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A Guide to Implementing Bluebeam Within Your Enterprise is intended to describe how
Bluebeam technology may best be utilized in an enterprise setting. Typically, large
organizations face unique challenges when implementing desktop applications. These
challenges range from finding the most efficient method of deploying an application to end
user workstations, to configuring an application for use in multi-user settings within the
network environment.

From the outset, Bluebeam Software has been designed to support large scale use within an
organization. This document provides guidelines for planning, deploying, and maintaining
Bluebeam within your organization.

Sections

1. Deployment - Describing the automated, unattended deployment of Bluebeam Software
using the MSI deployment package.

2. The Bluebeam Administrator – Providing an overview of the application that allows users
to manage their Bluebeam Software.

3. Managed Configurations - Defining locations for properties that may be centralized on a
network.

4. Revu Settings - Introducing Profiles, Preferences, and tool sets, along with a tutorial on
applying them to your organization.

5. Appendices – Provides technical parameters, configuration examples, and a full deployment
walkthrough.
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Net Deployment

Section 1
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Net Deployment Methods Section 1.01

All Bluebeam net deployment resources including software downloads can be found on
our website at: http://support.bluebeam.com/enterprise-installation

System administrators should deploy Bluebeam Software using the provided MSI Deployment
Package, which allows for an unattended installation across their network. The MSI
Deployment Package must be deployed with elevated privileges.

MSI Deployment Package (MSI Deploy)

The MSI Deploy package uses Microsoft’s Windows Installer framework to execute
installation using the Msiexec Utility. Parameters can be passed through command line or
can be configured through an MSI editor such as Orca or InstEd and run with a network
deployment vehicle such as Group Policy or SCCM.

Installation procedures outlined in the following pages are guidelines that allow an
administrator to apply this information as a supplement to normal deployment procedures.

In order to use this document, it is assumed that you are familiar with Windows command
line arguments. Administrators should also have the necessary infrastructure and resources
already in place to execute log-on scripts and deploy MSI packages. It is recommended that
you run your deployment in a test environment and verify success before fully deploying any
software over your network.

http://support.bluebeam.com/enterprise-installation
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Prerequisites Section 1.02

Before installing Revu, please consider these requirements to ensure a successful
deployment of the program. Listed below are the necessary prerequisites for Bluebeam Revu
2016.

l Windows Installer 4.5 or greater.
l Microsoft .NET Framework 4.5.0 or greater.
l The system on which Revu is being installed has no pending reboots.

Note: The Revu 2016 MSI installer automatically checks for pending reboots to ensure
that the Microsoft .NET Framework setup is complete as Revu will fail to install if it is not.
In environments where Windows Updates are centrally managed by the IT department, it's
possible for the pending reboot flag to not be cleared properly after a restart. In these
cases, Revu will fail to install even though all the prerequisites have been met. There is an
optional property (IGNORE_RBT) in the MSI that can be enabled to bypass this check.
Before enabling this property, however, ensure that .NET Framework 4.5.0 or higher is
installed and that the computer has been restarted. For more information on the MSI
parameters See "Appendix A" on page 59.

l All previous versions of Bluebeam Software must be removed before installation.

Note: The MSI automatically uninstalls all previous installations of Revu 2015 and any
MSI deployments of Revu 12.5 or higher; installations of Revu 12.1 or older, or
installations of 12.5/12.6 made via the stand-alone .exe or InstallShield Silent Setup
deployment package, should deploy the uninstall script included with the MSI manually.

An Internet connection is required to complete the automated authorization process of
Bluebeam Software. See "Section 1.04 - Authorization" on page 11 for details.

Prerequisites for older releases can be found on our website at
http://support.bluebeam.com/articles/bluebeam-installation-prerequisites-microsoft-net-
framework-and-windows-installer/

Compatibility Requirements

Supported Operating Systems

l Windows 7 Service Pack 1 (32-bit and 64-bit)
l Windows 8.1 (32-bit and 64-bit)
l Windows 10 (32-bit and 64-bit)

Recommended Minimum Hardware

l Display: 1024 x 768 high color, 32-bit

http://support.bluebeam.com/articles/bluebeam-installation-prerequisites-microsoft-net-framework-and-windows-installer/
http://support.bluebeam.com/articles/bluebeam-installation-prerequisites-microsoft-net-framework-and-windows-installer/
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l RAM:
l 32-bit Windows: 4 GB
l 64-bit Windows: 8 GB

l Hard Disk: Up to 4 GB of available space may be required
l Processor:

l Desktops and Laptops: 1 GHz processor or equivalent (recommended, see
discussion below)

l Tablets: Intel i3 processor or equivalent

When using Revu for general office applications, a general class computer that meets the
above requirements may be used.

Revu for Larger Sets of Engineering Documents

When working with large drawing sets (for example, construction project bid sets) in
which the PDFs may contain hundreds of large format drawings, it is recommended that
workstations have adequate memory and processor resources. A recommended hardware
configuration would be 64-bit Windows with an Intel i5 Dual Core or better processor, as
well as at least 8 GB of RAM. Revu can run on systems with lower specifications; however,
a workstation with these settings will provide the optimal performance.

Using Revu for OCR

When using the OCR functionality of Revu eXtreme, 64-bit Windows is highly
recommended for best performance.

Please check the Bluebeam website at
http://support.bluebeam.com/articles/compatibility-bluebeam-revu/ for the latest
compatibility notifications.

Microsoft .NET Framework 4.5.0 or Greater

Before installing Revu 2016, the Microsoft .NET Framework 4.5.0 or greater MUST be installed
and the computer must be restarted so as to complete the .NET Framework setup. Failure to
restart after installing the .NET Framework will prevent Revu from installing.

Staggered Deployment

Administrators required to deploy the .NET application separately may find that staggering
the .NET Framework deployment days prior to deploying Bluebeam is an efficient alternative
to deploying all applications at once. Staggering deployment over multiple days allows for
validation against unforeseen deployment issues that arise.

http://support.bluebeam.com/articles/compatibility-bluebeam-revu/
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Deployment Best Practices Section 1.03

Windows Installers

Best practices for deploying Microsoft’s Windows Installer can be found at:
http://msdn.microsoft.com/en-us/library/bb204770(VS.85).aspx

Best Practices for Deploying Bluebeam Software

If you are deploying to a virtual master image or template that you will use to create
Persistent virtual desktops:

l You must use Delayed Authorization so Revu is not registered on the master image.
l Consider using an Enterprise or Open License* in this situation. Though not required, this

provides the following benefits:
l If a virtual desktop is ever destroyed before unregistering Revu:

l An Enterprise License will automatically unregister the computer after 15 days.
l An Open License will manage itself. A license is only used while Revu is run-

ning.
l If using an Enterprise or Open License, you can use the Bluebeam Gateway to manage

the license.
l Refer to the Enterprise Administrator's Guide for license details.

If you are deploying to a virtual master image or template that you will use to create Non-
Persistent virtual desktops:

l Do not use Delayed Authorization. Revu should be registered on the master image.
l Verify that an agreement is in-place with your Bluebeam Account Rep. to account for this

setup.
l Consider using an Open License* in this situation. Though not required, an Open License

provides the benefit of managing itself: a license is only used while Revu is running.
l When using a Perpetual or Enterprise License:

l Revu is only registered once, so all users are essentially using the same seat of Revu.
You have to ensure licenses are purchased for all users that potentially access a
desktop containing Revu, or find a way to limit the number of users who can access
those desktops.

l Refer to the Enterprise Administrator's Guide for license details.

Delayed Authorization is recommended while deploying Revu through SCCM.

l By default the SYSTEM account is used to install software while deploying through SCCM.
l Typically the SYSTEM account does not have Internet access to contact our authorization

servers.

http://msdn.microsoft.com/en-us/library/bb204770(VS.85).aspx
http://support.bluebeam.com/wp-content/uploads/2016/08/Bluebeam_Enterprise_Admin_Guide.pdf
http://support.bluebeam.com/wp-content/uploads/2016/08/Bluebeam_Enterprise_Admin_Guide.pdf
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Note: *An Open License requires Revu eXtreme.

Installation Procedure

1. Determine the prerequisites for your network.
2. Close all other applications when installing Revu.
3. Deploy necessary prerequisites and restart.
4. Validate installation of components.
5. Confirm Internet access for authorization or enable Delayed Authorization.
6. Configure parameters for your chosen deployment method.
7. Test and confirm deployment on a test machine using an elevated command prompt.
8. Execute deployment of Bluebeam Software.
9. Restart the computer to ensure all custom settings take effect.

10. Validate installation of Bluebeam Software.
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Authorization Section 1.04

Bluebeam Software uses a node-locked licensing system. This allows a single instance of an
application to run on a specific machine. During installation, Bluebeam will attempt to
complete authorization. The application PbMngr5.exe attempts to access the Bluebeam
license server during this process. In order to succeed, systems must have a valid Internet
connection.

Uninstallation will also access the server and release a license in the same manner.

Ensure successful authorization by opening your firewall or proxy server to allow access to
Bluebeam’s license server. This address is configured as Port 443 for https. To register, you
must be able to access the license servers listed below.

Activation Server:

l https://activation.bluebeam.com (all installs)

Authorization Servers:

l https://bluebeam-us-east.accesscontrol.windows.net (2015.5 and 2015.6 installs)
l https://login.microsoftonline.com/ (2016+ installs)

Delayed Authorization

Delayed Authorization (DA) is a deployment parameter that programs the authorization query
to initiate after deployment is complete. Authorization will be delayed until the user logs
onto their computer and a save operation is performed through Bluebeam Software. This
includes any attempt to save in Revu or the Bluebeam PDF printer, as well as saving from any
Bluebeam plugin (AutoCAD, Solidworks, or MS Office).

Note: It is highly recommended in situations where the administrator account does not
have Internet access, such as when deploying with software such as SCCM, delayed
authorization can be used if users are granted basic Internet access. See "Appendix A" on
page 59 for more information about enabling Delayed Authorization in the MSI.

Install as Trial

Bluebeam Revu can be installed as a 30-day trial. Enter the word TRIAL in the BB_
SERIALNUMBER field of the MSI property table, or as BB_SERIALNUMBER=TRIAL in a command
line script. TRIAL must be entered in upper case. Do not modify the Product Key field when
installing as a trial.

License Gateway

A license gateway is available on our website allowing systems managers a view of their
current registration information at any time.

https://activation.bluebeam.com/
https://bluebeam-us-east.accesscontrol.windows.net/
https://login.microsoftonline.com/
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l License Gateway - https://portal.bluebeam.com
l License Gateway User Guide - http://support.bluebeam.com/articles/bluebeam-gateway-

user-guide/

https://portal.bluebeam.com/
http://support.bluebeam.com/articles/bluebeam-gateway-user-guide/
http://support.bluebeam.com/articles/bluebeam-gateway-user-guide/
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Upgrading Bluebeam Section 1.05

Major Upgrades vs. Minor Updates

Two types of upgrades are provided by Bluebeam: major upgrades, and minor updates. Major
upgrades consist of full version releases. Users with previous versions of Bluebeam Revu
(2015 and below) upgrading to Revu 2016 are performing a major upgrade. Minor updates
include those that occur between full releases such as 2015.1.1 – 2015.5, and other similar
releases.

In the circumstances of either update, all prerequisites (See "Section 1.02 - Prerequisites" on
page 7) remain the same, including uninstalling previous installations of Revu. Major and
minor updates are all full installations. As such, minor updates such as Revu 2015.5, can be
run on a system without a previous version of Bluebeam Revu installed.

MSI Deploy

The 2016 MSI automatically uninstalls MSI deployments of Revu 12.5 or higher; installations
of Revu 12.1 or older, or installations of 12.5/12.6 made via the stand-alone .exe or
InstallShield Silent Setup deployment package, should deploy the uninstall script, Uninstall
Previous Versions.txt, included with the MSI manually. This script will assist you in
uninstalling any previous version of Bluebeam you may have. It can be run as part of a Group
Policy Object prior to your MSI deployment, as a step in an SCCM task sequence, or simply
part of a log-on script.

Notes

1. The Bluebeam MSI Deploy will not access Microsoft to obtain .NET Framework prerequisites.
Verify installation of the Microsoft .NET Framework 4.5.0 or greater on each system prior to
deployment. The system must be restarted after installing Microsoft .NET Framework or
Revu will fail to install.

2. Remove previous versions of Bluebeam Software from each workstation before deploying
any update.

Examples

l Upgrading from version 2015 (MSI deployment or stand-alone .exe installation) to 2016 on
32-bit or 64-bit Windows 7= Do not deploy uninstall scripts, old version uninstalled auto-
matically.

l Upgrading from version 2015 (MSI deployment or stand-alone .exe installation) to 2016 on
32-bit Windows 8.1 or Windows 10 = Do not deploy uninstall scripts, old version unin-
stalled automatically.

l Upgrading from version 11.6 to 2016.x = Deploy Uninstall Previous Versions script.
l Upgrading from version 12.1 to 2016.x = Deploy Uninstall Previous Versions script.
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l Upgrading from version 12.5 MSI deployment to 2016.x = Do not deploy uninstall scripts,
old version uninstalled automatically.

l Upgrading from version 12.6 InstallShield Silent Setup deployment to 2016.x = Deploy Unin-
stall Previous Versions script.
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MSI Deploy Installation Section 1.06

MSI Deploy was designed and tested with the intention that administrators run the package
as a separate entity. While the MSI Deploy package may be run in conjunction with other
packages, users intending to build their own MSI for Bluebeam deployment are not
supported.

Note: We recommend against editing the MSI and prefer you pass all parameters from an
MST Transforms file or the command line. Editing an MSI invalidates Bluebeam's digital
signature on the file, which might be problematic in some environments. To avoid this, pass
any MSI Properties as part of a command line script or apply an MST Transform file. See
"Appendix C" on page 63 for details.

Upgrades
The Revu 2015.1 and higher MSI will automatically uninstall all previous
installations of 2015 and any MSI deployments of Revu version 12.5 and
higher. Deploy the Uninstall Previous Versions.txt script (rename to .bat) to
remove versions of Revu 12.1 or older, or installations of 12.5/12.6 made
via the stand-alone .exe or InstallShield Silent Setup deployment package.

Note that this will not remove any custom configurations of your program.

All configuration strings are
located under the Property
table. Click on the Property
header to sort alphabetically.
Critical parameters begin
with "BB_".

To automate the registration
process, input your serial
number and product key into
the fields listed below. See
"MST Transforms File
Creation" on page 16 or
Example Command Lines in
"Appendix C" on page 63 for
MST creation process using
Orca and InstEd MSI Editors.

BB_SERIALNUMBER: your 7-digit serial number

BB_PRODUCTKEY: your 12-character product key (must be entered in ALL CAPS)
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Warning: Do not edit any parameters in the MST other than those listed in "Appendix A" on
page 59.

Note: Save and Close the MSI/MST Editor before testing the deployment, otherwise the
installer will be marked as "in use" and will not run.

MST Transforms File Creation

Create MST Transforms file using InstEd:

1. Open MSI for edit-
ing.

2. Go to Transforms
> New Trans-
forms.

3. Give file a name
with an .mst exten-
sion.

4. Edit the Properties
table in the MST file
as desired.

5. Go to File > Save
to save the MST
file.

Create MST Transforms file using Orca:

1. Open MSI for editing.
2. Go to Transform > New Transform.
3. Edit the Properties table in the MSI file as desired.
4. Go to Transform > Generate Transform.
5. Save the file with an .mst extension.

Edit the MST file like you would the MSI file, then apply the MST Transforms file to your
command line options. See "Appendix C" on page 63 for details.

Once all necessary changes are made, save the file. Your MST is now reconfigured and ready
to be deployed. MSI deploy must be run with elevated privileges. A list of configurable
parameters is located in "Appendix A" on page 59 as well as in the MSI Deploy Readme file.
Use Group Policy, SCCM or another preferred application to execute your deployment of
Bluebeam Revu.

Note: Put both the MSI and MST in the same folder. DO NOT name the MST file "Transforms".
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The BluebeamAdministrator

Section 2



A Guide to Implementing Bluebeam Within Your Enterprise
Revised for Revu 2016.5

18 | Page

The BluebeamAdministrator Section 2.01

The Bluebeam Administrator allows you to configure the parameters of your Bluebeam
software suite. This includes enabling/disabling plugins, configuring the Bluebeam PDF
printer, changing default settings, and enabling debugging logs.

Sections of the Bluebeam Administrator are separated into tabs. The only tabs that pertain to
deployment are:

l NetConfig tab: Used to setup a Net Configuration to be shared across your organization.
l Printer tab: Used to create any custom page sizes to share.
l AutoCAD Page Sizes tab: Used to enable page sizes that should be available to users.

Note: Any custom printer pages created or AutoCAD pages selected will be managed by
the Net Configuration once those pages are created or enabled/disabled in their
respective tabs. See "Section 3.01 - Centralizing Net Configurations" on page 25.

The rest of the (tabs) information here is just for informational purposes. These tabs allow
the following functions:

l Control the loading and unloading of plugins integrated into AutoCAD, Revit, Navisworks,
SketchUp Pro, SolidWorks, and MS Office.

l Configure centralized network settings for the plugins.
l Control the PDF printer: setting up, adding page sizes and reinstalling the Bluebeam PDF

printer.
l Display log files.
l Enable Revu as the default PDF viewer.
l Backup, restore and reset the settings for Revu.
l Enable the PDF viewer plugin for Internet Explorer.
l Manage page sizes of the AutoCAD Plugin (CAD and eXtreme Editions only.)

You can access the Bluebeam Administrator from within Revu by going to Help >
Administrator or from the Windows Start > All Programs > Bluebeam Software menu.
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Several options in the Bluebeam Administrator can be modified post-install via the command
line. See "Appendix G" on page 79.
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The BluebeamAdministrator Tabs Section 2.02

Plugins Tab

The Plugins tab shows all
applications installed on your
system that are supported by
Bluebeam plugin technology.

On a system with multiple versions
of the same software, the Plugins
tab will show all supported versions
of that application running on the
workstation.

Net Config Tab

The Net Config tab manages the
controls for PDF creation through
Bluebeam plugins and the Bluebeam
PDF printer. These settings apply to
elements such as stamps, printer
page sizes, and global page setups
for all Bluebeam plugins.

Net Config can be managed from a
central location or left as default
and managed by the user. See
"Section 3.01 - Centralizing Net
Configurations" on page 25
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Printer Tab

The Printer tab controls aspects of the Bluebeam PDF printer driver. Through this tab, you
can control folder options, add/edit printer page sizes, and uninstall/reinstall the printer
driver.

Folder Options

Folder Options allows you to configure the default save path for PDF conversions done with
the Bluebeam PDF printer.

Source folder sets the default save path to the same folder as the source file. The source
folder option is only valid when using the Bluebeam Stapler to create PDFs. It is not valid
when creating a PDF using the Bluebeam PDF printer.

Last Saved Folder will set the default save path to the last folder that was used.

Custom Projects Folder allows you to assign the default save path to a location that you
specify.
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Logging Tab

The Logging tab manages
debugging information that can be
used to troubleshoot errors and
problems within your software.

Check the box marked Debugging
On to enable detailed logging.

Revu Tab

The Revu tab controls the default
viewer option and icon color
selection. Also on this tab is the
Reset Settings button which allows
a user to switch all settings back to
default. See "Section 4 - Revu
Settings" on page 30 for more
information on these settings.

Revu x64 has an extra option that
allows users to default to the 32-
bit viewer easily. There is also a
Backup Settings button that allows
users to back up tool sets and
Profiles easily.

The web browser plugin to IE can also be enabled and disabled from this tab.

Reset Settings can be helpful in resolving some technical issues by resetting all data stored
in the UserPreferences.xml file. See "Section 4 - Revu Settings" on page 30 for more
information.
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AutoCAD Page Sizes Tab
(CAD and eXtreme Editions
Only)

The AutoCAD Page Sizes tab shows
the page sizes available to the
plugin for AutoCAD. This tab allows
you to select which standard large
format page sizes you wish to
appear in your drop-down list of
page sizes in the plugin for
AutoCAD (ANSI, ARCH, or ISO)..

Check/uncheck the specific type
(ANSI, ARCH, and/or ISO) or the
individual page size from the list to
select the ones you wish to appear
in the page size list for AutoCAD.
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Managed Configurations

Section 3
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Centralizing Net Configurations Section 3.01

The Net Config tab of the Bluebeam Administrator manages the configurations for all
Bluebeam supported plugin applications as well as the Bluebeam PDF printer. These settings
apply to elements such as stamps, printer page sizes, and global page setups for all
Bluebeam plugins.

When a Custom or Global page setup is selected within the Bluebeam plugin for your
application it will be saved to this directory for others to access.

On the Page Setup
tab, click Manage
to open the Page
Setup Management
dialog box, then
click Add to create
a new, customized
page setup.

Centralization

Locations for these critical elements used in daily PDF creation
workflow, such as printer page sizes, text stamps, and plugin
settings can all be centralized through the Bluebeam
Administrator's Net Config tab. Stamps and printer page sizes
will automatically show up in the drop-down menus of all
workstations that are linked to the managed location. A
network configuration can also be defined during deployment
of the software.

Centralizing Stamps, Tool Sets, and custom page sizes allows
the systems administrator or CAD manager to update the
database for all users at once.

This efficiently enhances the rate of workflow. Users are also able to contribute to the
database if rights are given.
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Managing Net Configurations Section 3.02

There are two main selections from the Net Config tab, the Managed Net Configuration or
Unmanaged.

In a standard installation, Net
Config defaults to the Unmanaged
profile. All settings are stored
locally in various locations on each
workstation.

By pointing the Net Config path to
Managed Net Configuration, new
stamps and printer page sizes
become centralized at the location
specified.

If there is anyone in your
organization that is responsible for
creating custom Stamps and
custom Printer page sizes, be sure
to gather those items and copy
them into their respective folders
on the centralized location before
selecting the Managed Net
Configuration location. This will
ensure they are copied over to the
Net Configuration location.

Specific settings can be centralized by choosing Unmanaged, then browsing to the desired
location for those preferences.
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To change from Unmanaged to a Managed Net configuration, open the Bluebeam
Administrator to the Net Config tab and select Managed Net configuration. A dialog box
will appear that allows you to browse for a folder or create a new folder to store your
settings.

After clicking Select Folder, choose one of the copy options:

l Copy All adds all defaults to the network directory.
l Merge takes all locally defined settings and merges them with any existing configurations

in the shared folder.
l No Copy will point to the network location and not integrate any local settings to the net-

work location.
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The new Net Config setting will be
shown in the Bluebeam
Administrator.

The folder structure shown on the
left will be created in the
designated folder.

Note: You can restrict users from making modifications to the shared network directory
by setting folder permissions to read-only. They will be able to point to the directory but
prohibited from modifying files within the directory.

Note: When deploying a managed Net Configuration, the computer must be restarted
after Revu is installed (but before opening the Bluebeam Administrator) in order for the
NetConfig setting to apply. Failure to restart first will apply the default (local) paths for
the Net Config.
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Net Config in Deployment Section 3.03

You can also define the Net Config location during deployment. Both fully qualified and UNC
paths are supported.

MSI Deploy

To designate a central location for your Net Config settings, enter the path (UNC or absolute)
as the Value of the BB_NETCONFIG property in your MSI editor.

Note: We recommend against editing the MSI and prefer you pass all parameters from an
MST Transforms file or the command line. Editing an MSI invalidates Bluebeam's digital
signature on the file, which might be problematic in some environments. To avoid this,
pass any MSI Properties as part of a command line script or apply an MST Transform file.
See "Appendix C" on page 63 for details.

Note: When deploying a managed Net Configuration, the computer must be restarted
after Revu is installed (but before opening the Bluebeam Administrator) in order for the
NetConfig setting to apply. Failure to restart first will apply the default (local) paths for
the Net Config.



A Guide to Implementing Bluebeam Within Your Enterprise
Revised for Revu 2016.5

30 | Page

Revu Settings

Section 4
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Introduction to Revu Section 4.01

In an enterprise environment, centralizing your files and settings offers many potential
advantages. The tradeoff to this option is that workstations become more dependent on the
network for daily operations; some shared resources (for example, Tools Sets or Profiles) can
be used in an “offline mode,” but they will not benefit from things like synchronized updates
until the user is back on the network (see "Section 4.08 - Sharing Profiles on a Network" on
page 41 and "Section 4.10 - Managing Tool Sets" on page 45 for more information).
Centralization offers the ability to standardize integration among users, grants the system
administrator or CAD manager increased security, and drastically speeds up the time needed
for everyone to update configurations.

With this in mind, Bluebeam has designed Revu such that critical features needed during
everyday workflow can easily be managed from one location. These settings are stored in a
hierarchy.

In this hierarchy, User Preferences encompass all of the features and store them locally on
the workstation. Profiles contain all other elements of the Revu interface including panels
and toolbars, as well as what tool sets are displayed in the Tool Chest.

Bluebeam Revu’s Hierarchy of Configurable Settings

By default, all of this information is stored locally in the user’s Revu\16\ folder:

C:\Users\<Username>\AppData\Roaming\Bluebeam Software\Revu\16\
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Reset Settings

The Reset Settings button on the Revu tab of the Bluebeam Administrator archives all data of
the hierarchy into a Revu Settings Backup.zip file stored in the Revu\2016\ folder. When
Revu recognizes that a UserPreferences.xml file is not present, it will regenerate the file with
default characteristics.
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User Preferences Section 4.02

The top most layer of the hierarchy contains the user preferences. User preferences are
contained within an .xml file named UserPreferences.xml. This file contains settings that are
user specific as well as settings that should be common to all Profiles.

User Preferences cannot be centralized or deployed in a network location. This is
because low-level settings, such as the username data attributed with a markup are included
in this location. However, it is recognized that there is a need to standardize preference
traits across users in an organization. To accommodate this requirement, Bluebeam Revu
allows you to import and export these preferences through a file called RevuPreferences.xml.

l User Preferences are workstation specific and cannot be managed or centralized to a
server.

l Revu Preferences are attributes of the UserPreferences.xml file that you can export to
another workstation. This file can also be stored on the network and included as part of a
deployment.

Manageable Items:

l Revu Preferences
l Profiles
l Tool Sets
l Stamps
l Hatch Patterns
l Printer Page sizes
l Plugin Settings

Workstation Specific Items:

l Revu\2016\ folder
l UserPreferences.xml file
l Debugging logs
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Revu Preferences Section 4.03

Importing and Exporting Revu Preferences

RevuPreferences.xml contains manageable preference data stored in the Preferences window.
This window is accessed by clicking Settings > Preferences (or pressing CTRL+K) inside
Revu. To export these settings, simply click Export and save them to any location on your
network. Importing can then be done locally by each individual user, or the path and file
name can be defined during deployment.

Preferences Menu
Detailed descriptions of each category in the Preferences window can be
found in the Bluebeam Revu Help Guide. You can access this help guide
through the Help menu of Revu.

The Import and Export buttons are
located in the Preferences list.

When exporting preferences, keep
the default file name
RevuPreferences.xml.
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Deploying Preferences Section 4.04

Exported preferences can be deployed at installation using the BB_REVUPREFERENCES
parameter during the MSI Deploy. An example is given below.

When upgrading, deploying RevuPreferences.xml will give the user an updated set of
preferences without overriding any other existing data such as Profiles.

MSI Deploy

Revu CAD silent MSI deploys and specifies a Revu Preferences file to be deployed:

Note: We recommend against editing the MSI and prefer you pass all parameters from an
MST Transforms file or the command line. Editing an MSI invalidates Bluebeam's digital
signature on the file, which might be problematic in some environments. To avoid this,
pass any MSI Properties as part of a command line script or apply an MST Transform file.
See "Appendix C" on page 63 for details.

Note: A fully qualified path or UNC path, including the file name, to RevuPreferences.xml
must be included with the parameter.

Deploying Preferences Post-Installation
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For existing installations (Revu 11 and above), there is a way to push out and merge
preference changes with existing user preferences. Follow the steps in "Section 4.03 - Revu
Preferences" on page 34 to modify and export a copy of RevuPreferences.xml.

When merging preferences, you need to edit RevuPreferences.xml with a text editor and add
Merge=”True” (case sensitive) into the header of this file in order to merge the settings (see
below). When doing this it is recommended that you delete everything but the settings you
want to change from the XML so as not to change any other settings.

<RevuPreferenceDictionary Version="1" Merge="True">

Make these edits to your RevuPreferences.xml file and copy it to
C:\ProgramData\Bluebeam Software\Bluebeam Revu\2016\Revu. Revu looks at this
folder when it launches for new preferences. Existing user’s settings are stored in a
UserPreferences.xml file located in a Bluebeam folder under the user’s roaming profile in
Windows. This UserPreferences.xml gets saved and updated when Revu closes. In order for
these new preferences to merge, the modified date of the RevuPreferences.xml file in the
ProgramData folder must be newer than date of the UserPreferences.xml file for the user. If it
isn’t, Revu will ignore the preferences so as not to overwrite newer settings with something
that might be outdated.

For example, if you are running your own Studio Server, you will need to change the URL of
the Studio Server that Revu connects to in order to direct it to your Server instead of
Bluebeam’s. Here is an edited version of RevuPreferences.xml to make this change.

<?xml version="1.0" encoding="utf-8"?>

<RevuPreferenceDictionary Version="1">

<Studio>

<Force.Proxy>False</Force.Proxy>

<ServerCache>{"active":
{"RequestedAuthMode":0,"ServerEmail":null,"ServerPassword":"","Serve
rURL":"Studio.CompanyXYZ.com","ServerUserName":""},"servers":
[{"RequestedAuthMode":0,"ServerEmail":null,"ServerPassword":"","Serv
erURL":"Studio.CompanyXYZ.com","ServerUserName":""}]}</ServerCache>

<Toolbar.Integration.Only>True</Toolbar.Integration.Only>

<URL>Studio.CompanyXYZ.com</URL>

</Studio>

</RevuPreferenceDictionary>

There are different ways you can deploy this file to your users, but to test this process,
follow these steps:

1. Close Revu
2. Copy RevuPreferences.xml to C:\ProgramData\Bluebeam Software\Bluebeam

Revu\2016\Revu

3. Open RevuPreferences.xml, add a space and then Save it. This will ensure the date modified
is later than Revu's UserPreferences.

4. Open Revu and look at the Preferences to see that this setting has been changed.
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Best Practices Deploying Settings Section 4.05

Best Practices for Deploying Revu Settings

See the noted sections in parentheses for instructions on the related step. A step-by-step
walkthrough of this procedure is outline in "Appendix D" on page 66

1. Install Revu on a workstation used for the master configuration.
a. Configure preference settings then export them to a central

location. ("Section 4.03 - Revu Preferences" on page 34)
b. Configure Profiles. ("Section 4.07 - Read-Only Profiles" on page

40)
c. Add tool sets and hatch patterns to configured Profiles.

("Section 4.10 - Managing Tool Sets" on page 45 and "Section
4.14 - Managing Hatch Pattern Sets" on page 50)

d. Export the Profiles to a central location with Include
Dependencies checked. ("Section 4.08 - Sharing Profiles on a
Network" on page 41)

2. Define the Net Config location through the Bluebeam Administrator
("Section 3.02 - Managing Net Configurations" on page 26)

a. Add stamps, printer page sizes, etc to the new location.
3. Deploy Bluebeam Software ("Section 1.03 - Deployment

Recommendations" on page 9)
a. Configure authorization information ("Section 1.04 -

Authorization" on page 11, "Section 1.06 - MSI Deploy
Installation" on page 15)

b. Configure installation parameters ("Section 1.06 - MSI Deploy
Installation" on page 15)

c. Define location of Net Config settings ("Section 3.03 - Net
Config in Deployment" on page 29)

d. Define location of RevuPreferences.xml ("Section 4.04 -
Deploying Preferences" on page 35)

4. Deploy your configured Profiles through the command line argument
or post-install customization. ("Section 4.17 - Revu Command Line
Parameters" on page 56, "Section 4.16 - Post-Installation
Customization" on page 54)
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Profiles Section 4.06

Profiles are the second layer in the hierarchy, designated with a .bpx extension. They contain
the overall layout of the Revu user interface such as toolbar positions, Tool Chest contents,
and panel configurations. Since Profiles do not store any user specific data, they are well
suited for centralization in a network environment.

Profiles can also be used to shape the user interface of Revu for particular job operations
within an organization. You can create a simplified interface by disabling all but the most
simple markup functions for basic users, while allowing advanced features for other users
that require them.
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Read-Only Profiles Section 4.07

By default, Revu is setup to remember the last known settings to the user interface once it is
closed. When a user makes changes to a Profile, such as enabling a tool bar or hiding the
Properties tab, these changes are saved to the selected Profile. In organizations where
Profiles are standardized or centralized, systems administrators will want to prohibit this
action from affecting other users whom also access the same Profile.

With this in mind, this function can be disabled by adding read-only attributes to the Profile.
In this state, a Profile cannot be overwritten when Bluebeam Revu is shutdown. Any changes
made to the Profile will not be saved when the program is closed.
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Sharing Profiles on a Network Section 4.08

Profiles can be centralized by selecting a network location where they are stored. Use the
Browse button next to the Location field to point a workstation to the shared location. Any
new or modified Profiles stored in this location will immediately be available to all users on
the network. Users who go offline can continue to use the profile that was active when they
went offline, but updates and some of the shared elements of other profiles (notably, some
tool sets) will not be available until they go online again. Note that shared Profiles are read-
only: any changes made by a user (for example, turning a toolbar on or off), are made for
their session only and will be lost when Revu is closed.

Click Add from the Manage Profiles
window and name the new Profile in
the Add Profile dialog box that
appears.

Select the newly created Profile and
click OK when finished.

Change the Revu interface by
turning on and off toolbars, adding
tool sets, and so on.

Once a Profile is created, it may be exported to a central location. The Profile can then be
deployed through a command line parameter (See "Section 4.17 - Revu Command Line
Parameters" on page 56).
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Export a Profile

Save the Profile before exporting or else your changes
will not get exported.

Include Dependencies: This will
store all items in the Profile along
with it. This means that custom
tool sets, columns and statuses, as
well as hatch patterns and line style
sets will also be stored within the
Profile.

Check this box if you want to
include these resources within your
Profile when it is exported.

The exported file will now show up
in the folder you save it to.

Once a Profile is created, it may be imported to each workstation manually by the user or
deployed through a command line parameter (See "Section 4.17 - Revu Command Line
Parameters" on page 56).
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Import a Profile

Exported Profiles can be copied to a network drive or sent directly to users who can simply
double-click the Profile (.bpx) file to import it into Revu automatically. Profiles can also be
imported from within the application.

Click Import to select a Profile to
import. You can also browse to a
location where Profiles are stored to
configure Revu to work from a shared
Profile directory by clicking the
browse (...) button to the right of the
Location field.

The imported file will now show up
in the Profiles list of your
workstation, or the available Profile
in the shared Profile directory will
be listed.
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Tool Chest Section 4.09

Revu includes a powerful advantage for making the process of marking up PDF files much
more efficient. Once a markup is created, you can recall it using the Tool Chest. The Tool
Chest stores groups of tool sets which allow users to conveniently store frequently used
markups in a central, easily accessible panel. Remember that Tool Sets (and Hatch Patterns)
are included with exported Profiles when the “Include Dependencies” option is checked.
Administrators can create and share these tool sets among different users of Revu across a
network.

Importing/Exporting vs. Adding Tool Sets

There are two ways for users to share tool sets over a network. Importing/exporting or
adding.

l Add allows a tool set saved in a central location to be recognized in the Tool Chest without
copying it onto the workstation locally. This allows the tool set to easily be updated. Use
Windows File Permissions on the .btx files to control who can check-out the tool sets for
editing. (See "Section 4.11 - Locking Tool Sets" on page 47.)

l Import saves tool sets directly to the user’s system locally. This allows the user to cus-
tomize their tool set without affecting anyone else.

l Export saves your toolset to a specified directory. Exported tool sets can then be shared or
archived.
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Managing Tool Sets Section 4.10

All tool sets are saved as a .btx file that can be copied to a network drive or sent directly to
users. As with Profiles, users can double-click a .btx file to import it into Revu
automatically. Additionally, tool sets may be imported from within the application or
deployed through a command line parameter (See "Section 4.17 - Revu Command Line
Parameters" on page 56). Tool sets may also be shared from a centralized location. Shared
tool sets can be used while offline, but will not be updated and cannot be checked out while
offline.

Click on the Manage Tool Sets icon to bring up the window shown below. Select either Add
or Import to bring a new or existing tool set into your Tool Chest.

Add recognizes the tool set on a
mapped network without bringing it
into the workstation locally.

Use Import to allow user
customization or when tool sets are
being exchanged within a
workgroup or e-mailed.
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The new tool set will show up in the
Manage Tool Sets window and in
your Tool Chest.
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Locking Tool Sets Section 4.11

An administrator may grant any team member permission to the lock which would allow
them to provide updates. If the tool set is locked, you may attempt to obtain permission by
clicking on the Lock icon.

Tools shared across the network are
considered locked, as indicated by a blue
lock icon in their title bar. This prevents
more than one user from making changes
at any one time.

If you have write permissions to the file,
the lock icon will change into a
checkmark indicating that you may now
add tools to that particular tool set.

If you go offline, shared tool sets will go
into an offline mode. Tool sets cannot be
checked out when in offline mode.
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Read-Only Tool Sets Section 4.12

Any tool set can be marked read-only. When in this state, the tool set cannot be unlocked or
modified until that attribute is removed.
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Hatch Patterns Section 4.13

Revu includes several standard hatch patterns (brick, diagonal, weave, and so on) used for
filling in markups. Hatch patterns are stored in Hatch Pattern Sets, designated with the .bhx
file extension.

Hatches may be centralized on a network
drive and are imported/exported or added
in the same fashion as Tool Sets.
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Managing Hatch Pattern Sets Section 4.14

Hatch pattern sets are managed through the Manage Hatch Pattern Sets window. As with
Profiles, hatch patterns may also be imported to each workstation or deployed through a
command line parameter (See "Section 4.17 - Revu Command Line Parameters" on page 56).

Select either Add or Import to bring a new or existing hatch pattern set into your Hatch
Pattern Set list.

The new set will show in the
Manage Hatch Pattern list as well as
the Hatch drop down in Revu.
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SharePoint & ProjectWise Integration Section
4.15

Revu has direct integration into Bentley ProjectWise and Microsoft SharePoint document
management systems. You can Check-In, Checkout and view files from either a ProjectWise
DataSource or SharePoint Document Library directly from within the Revu interface.

To Login

By default, your Windows account login credentials will be attempted first whenever you
login to a SharePoint site. If the login fails, you will then be prompted to enter credentials for
that site. Those credentials can be stored in Revu to suppress any this prompt.

Go to Settings > Preferences (or press CTRL+K). Here you can add Login and Account
information for ProjectWise or SharePoint. To setup a login click Add, choose the system
from a pull down list and enter your login name and password.

Note: When RevuPreferences are exported, login credentials are not included. Only the
site name or data source are exported.

Revu can store login data to
suppress any future prompts.
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Revu Server-Side SharePoint Integration Guide

Revu can be integrated into the Internet Explorer browser so that an edit option appears in
the SharePoint dropdown as shown below. This is required for any organization looking to
integrate SharePoint check-in/check-out from Internet Explorer.

This configuration is global to your SharePoint server and cannot be enabled only for specific
sites or libraries. The Bluebeam icon and Edit In strings are optional and do not affect the
functionality. If users who access these files do not have Revu, the files will still open in
their default PDF viewer.

1. Download the icpdf.gif from http://www.blue-
beam.com/us/support/articles/images/icpdf.gif, then add it to this folder:

l SharePoint 2013: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\15\TEMPLATE\IMAGES

l SharePoint 2010: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\14\TEMPLATE\IMAGES

l SharePoint 2007: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\12\TEMPLATE\IMAGES

2. Navigate to the following path:
l SharePoint 2013: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\15\TEMPLATE\XML\DOCICON.XML

l SharePoint 2010: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\14\TEMPLATE\XML\DOCICON.XML

l SharePoint 2007: %COMMONPROGRAMFILES%\Microsoft Shared\web server
extensions\12\TEMPLATE\XML\DOCICON.XML

3. Add (or replace) the following line into the DOCICON.XML file:
<Mapping Key="pdf" Value="icpdf.gif" EditText="Bluebeam Revu"
OpenControl="Revu.Launcher" />

http://www.bluebeam.com/us/support/articles/images/icpdf.gif
http://www.bluebeam.com/us/support/articles/images/icpdf.gif
http://www.bluebeam.com/us/support/articles/images/icpdf.gif
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Note: Only add this line if there is no existing entry for “pdf” in DOCICON.XML ; if
there is an existing entry, be sure to replace it. This might not function properly if
there are two entries for Mapping Key="pdf" in DOCICON.XML.

4. Restart IIS. The service must be restarted before SharePoint users will see the change.
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Post-Installation Customization Section 4.16

For new installations, some default settings can be deployed by pushing out an edited copy
of the default UserPreferences.xml after installation. Default Preferences, Profiles, tool sets,
hatch patterns, and line styles for Bluebeam Revu are automatically installed into
C:\Program Files\Common Files\Bluebeam Software\Bluebeam Revu\2016\Revu\1.
Modifying the contents of this folder post-install gives you an alternate method for
deploying resources like Profiles and Tool Sets.

Modify the contents of this folder post-install to:

l Deploy custom default preferences that cannot be included in RevuPreferences.xml.
l Specify a particular Profile as the default active Profile.

l This bypasses the Welcome & Studio dialogs.
l Point Revu to a shared Profile directory.

l Deploy custom Profiles and tool sets or delete any of the defaults to control which are avail-
able.

l If custom tool sets are deployed to this folder post-install, a modified Profile that
includes these tool sets also needs to be included.

Open UserPreferences.xml found under Common Files in a text editor. The example below:

l Sets Construction as the default Active Profile.
l Sets \\CompanyXYZ\Bluebeam\Profiles as the Shared Profile directory.

l Note that the Active Profile file (e.g. Construction.bpx) must exist in this location
<?xml version=”1.0” encoding=”utf-8”?>

<RevuUserPreferences Version=”2”>

<Record Key=”ProfileManager”>

<Active>Construction</Active>

<Path>\\CompanyXYZ\Bluebeam\Profiles</Path>

</Record>

Note: Do not to delete anything from this file, only add the desired changes. Deleting
information from this file can cause Revu to not function correctly.

After Revu is installed, copy your edited version to C:\Program Files\Common
Files\Bluebeam Software\Bluebeam Revu\2016\Revu\1 and overwrite the existing
version. When Revu is launched for the first time, the contents of this folder will be copied to
create the user’s Revu Settings in their roaming profile (%appdata%\Bluebeam
Software\Revu\16\). If you have included settings via RevuPreferences.xml, these will
automatically be included.

When using a custom Profile, that Profile (.bpx) file must be copied to the Revu folder as well.

1On x64 systems this folder also exists under Program Files (x86), so overwrite both
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Note: This method only works for new installations, where a user has not previously run
Revu. For upgrades and existing installations, "Section 4.17 - Revu Command Line
Parameters" on page 56.
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Revu Command Line Parameters Section 4.17

Command line parameters allow the ability to quickly deploy settings silently to a
workstation running Bluebeam software. They can also be set up as a .bat file to easily:

l Import a tool set into the current profile directory
l Import a Revu profile into the current profile directory
l Import a Hatch Pattern

As these are user-specific settings, they only apply to the user running the command line
(that is, the current user) and should not be run as the Administrator. Making them part of a
logon script is recommended.

The commands listed below show you how to deploy a command line parameter across your
network. Revu must first be installed on a system in order for these commands to execute.

l If the file is a tool set (*.btx), Revu imports the tool set into the current profile directory.
l If the file is a profile, Revu will import into the current profile directory.

Silent Mode: add /s

This optional command turns off prompting as it is encountered when Revu processes the
parameters listed below. The Revu splash screen and UI will momentarily flash, however. The
splash screen can be disabled in Revu’s General Preferences, but the appearance of the UI
cannot be prevented.

Profile Commands:

Import and activate a specified profile. Use this command to import a new profile into the
current profile location of your Revu session.

l /bpximport:[File]

Point the profile path to a specified directory. Use this only when designating a new profile
directory. Make sure the profile you specify is located here as well.

l /bpxdir:[Path]

Designate a specific profile as active within the profile folder defined in your Revu session.

l /bpxactive:[Name] For names with spaces, add quotations such as /bpxactive: "bb

custom profile"

Tool Set Commands

Point to a tool set in a non-default location without importing the file locally.

l /btxadd:[File]
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Import the tool set into the current profile directory and add it.

l /btximport:[File]

Hatch Pattern Commands

Adds the hatch pattern set without importing the file.

l /bhxadd:[File]

Import the hatch pattern set into the current profile directory and add it

l /bhximport:[File]

Line Style Commands

Adds the line style set without importing the file.

l /blxadd:[File]

Import the line style set into the current profile directory and add it

l /blximport:[File]

Example

l Import the Power Profile.
l Set the active profile to be Power.bpx.
l Import the tool sets toolset1.btx and dimensions.btx to that profile.

1. Enter silent mode /s.
2. Import the Power Profile from U:\netprofiles.
3. Activate the profile Power located in U:\netprofiles\Revu.
4. Import toolset1.btx to the active profile of Power.
5. Import dimensions.btx to the active profile of Power.

"C:\Program Files\Bluebeam Software\Bluebeam
Revu\2016\Revu\Revu.exe" /s
/bpximport:"U:\netprofiles\Power.bpx"
/bpxactive:Power/btximport:"U:\netprofiles\Revu\toolset1.btx"
/btximport:"U:\netprofiles\Revu\dimensions.btx"
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Appendices

Section 5
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Appendix A Section 5.01

MSI Deploy Parameters

MSI Deploy will not automatically remove previous installations of Revu version 12.1 or
older, or installations of 12.5/12.6 made via the stand-alone .exe or InstallShield Silent
Setup deployment package. It will automatically uninstall MSI deployments of Revu version
12.5 or higher. If you are upgrading, we included a text script named Uninstall Previous
Versions.txt that will assist you in uninstalling any previous version of Revu you might have.

Install ORCA or a similar MSI editor (such as InstEd) to edit your file or refer to "Appendix C"
on page 63 for information on configuring the install from a command line. Refer to
instructions below to customize the MSI database for your organization.

All strings below are located under the Property table. Click on the Property header to sort
alphabetically. Critical parameters begin with "BB_".

Warning: Do not edit any parameters in the MST other than those listed below.

Mandatory Strings

These three parameters are required for a successful deployment. All other parameters are
optional.

BB_SERIALNUMBER: Enter your 7-digit serial number here.

BB_PRODUCTKEY: Enter your 12-character product key. Product key must be entered in
ALL CAPS.

BB_EDITION: Enter "0" for Standard, "1" for CAD, "2" for eXtreme.

Binary Flags

These parameters are optional.

BB_DEFAULTVIEWER: "0" to not change the default PDF viewer, "1" to set Revu as default.

BB_DESKSHORTCUT: "0" to disable, "1" to install Revu desktop shortcut.

BB_DESKSTAPLER: "0" to disable, "1" to install Stapler desktop shortcut.

BB_REDICON: "0" to keep default blue PDF file icon, "1" to use the red icon.

BB_IE_PLUGIN: "0" to disable, "1" to install Bluebeam Internet Explorer PDF Viewer plugin.

BB_QUICKLAUNCH: "0" to leave disabled, "1" to enable Revu Quick Launch

Optional Strings
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(Unless otherwise noted, leave as "0" to ignore)

BB_FEATURES: leave as "65535" to ignore. Used for disabling features. See "Appendix E"
on page 76

BB_JOBOPTIONS: specify fully-qualified path or UNC to the folder containing your
modified .JobOptions files.

Job Options: This option will replace default versions of .JobOptions files (found in
C:\ProgramData\Bluebeam Software\Bluebeam Revu\2016\Brewery\V45\Settings)
during installation. The Bluebeam Plugin Settings and Advanced Settings in the Save As
dialog are controlled by the JobOptions files.

l Note that files must not be read-only.
l Files must be contained within valid sub-folders (such as Printer Driver or

AutoCAD.Plugin.)
l It is not necessary to include a complete set of files.
l Can be edited with a text editor to increase resolution (for example,

%DownSampleResolution 600)

BB_NETCONFIG: specify fully-qualified path or UNC to your managed Net Configuration.

BB_NEW_INSTALL_PATH: specify fully-qualified path.

BB_PAGESIZE: set to "A4" to override default Bluebeam PDF printer page size.

BB_REVUPREFERENCES: setting this option will deploy a RevuPreferences.xml file
(exported from the Preferences dialog). Specify fully–qualified path or UNC, including the
file name.

MBCODE: 4-bit flag for custom plugin
configuration. Leave as default "1023" to
enable all plugins. "1" Office, "2"
AutoCAD, "4" AutoCAD LT (32 bit only),
"8" SolidWorks, "16" Revit/Navisworks,
"32" Internet Explorer plugin, "64"
ProjectWise, "128" Outlook, "256"
SketchUp Pro, "1023" to install all
plugins, "0" to disable all plugins. (For
example, for only Office and AutoCAD,
change the value to 3 (2+1).)

DA: "0" for standard authorization, "1"
for delayed authorization

IGNORE_RBT: set to "1" to disable the check for pending reboots. When enabling this,
systems must already have .NET Framework 4.5.0 or higher installed and the computer
must have restarted once in order for its setup to complete.

Optional Post-install step
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To show the edition of Revu (i.e., Standard, CAD, or eXtreme) with the product name in the
Programs and Features/Add or Remove Programs (ARP) window:

l Deploy the included program ARP_Modifier_v16xx.exe.
l Note that ARP renaming is determined from the BB_EDITION flag, not from the serial number

registration.
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Appendix B Section 5.02

Language Transforms

The MSI can be used to deploy Revu in the language of your choice. By default the MSI is
configured to install in English.

Note: To install Revu in a different language you must use a Language Transforms value that
represents the language you want to install.

Valid languages and their corresponding transform values are:

l 1030 - Danish
l 1031 - German
l 1033 - English
l 1034 - Spanish
l 1035 - Finnish
l 1036 - French Standard
l 1040 - Italian
l 1041 – Japanese
l 1042 - Korean
l 1043 - Dutch
l 1044 - Norwegian
l 1053 - Swedish

Note: You must use an msiexec.exe command line installation to pass a Language
Transforms value.

Example Language Transforms

Basic install of Revu in German:

msiexec /i "Bluebeam Revu x64 16.msi" TRANSFORMS=:1031

The “:” in the above example “:1031” tells the command to look for the Language Transforms
inside the MSI and 1031 passes the German language to the Transforms.

Basic install of Revu in German and passing an MST Transforms file:

msiexec /i "Bluebeam Revu x64 16.msi" TRANSFORMS=:1031;MyTransforms.mst

When you also pass an MST Transforms with a Language Transforms, you should include the
MST file name along with the TRANSFORMS parameter separated by a semi-colon. The
Language value must be defined first then the MST transforms file, as shown here:
TRANSFORMS=:{language_value};{mst file}
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Appendix C Section 5.03

It is also possible to configure an MSI deployment by passing parameters to the install from
a command line instead of editing the MSI directly. See "Appendix A" on page 59 for a
complete list of configurable MSI parameters.

The Bluebeam MSI deployment package is run via the Msiexec utility using the following
syntax:

msiexec /i {Package}

Parameters

/i

Installs or configures a product.

Package

Specifies the name of the Windows Installer package file.

Example Command Lines

In the following examples, be sure to add the file path to the MSI you are deploying.

Note: Be sure to replace anything in italics with your license information.
DO NOT include the { } brackets in your script.

Basic install of Revu passing the minimum number of properties necessary for a successful
deployment, including Delayed Authorization (DA=1) and /qn for a silent installation:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} DA=1 /qn

Basic silent install of CAD Edition:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION=1 /qn

Basic install of Revu using an MST Transforms file:

msiexec.exe /i "Bluebeam Revu x64 16.msi"
TRANSFORMS="MyTransforms.mst"

Basic install of Revu in German:

msiexec /i "Bluebeam Revu x64 16.msi" TRANSFORMS=:1031

Basic install of Revu in German and passing an MST Transforms file:

msiexec /i "Bluebeam Revu x64 16.msi" TRANSFORMS=:1031;MyTransforms.mst



A Guide to Implementing Bluebeam Within Your Enterprise
Revised for Revu 2016.5

64 | Page

Basic silent install; specifies an A4 default page size for the Bluebeam Printer:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_PAGESIZE=A4 /qn

Basic silent install; specifies a central location "u:\bb-config" for Bluebeam settings:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_NETCONFIG="u:\bb-
config" /qn

Basic silent install; specifies not making Revu the default PDF viewer, and not placing a
short– cut for Revu on the desktop:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_ DEFAULTVIEWER=0
BB_DESKSHORTCUT=0 /qn

Basic silent install; specifies a non–default installation path, and enables the Bluebeam IE
Viewer plugin:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_NEW_INSTALL_
PATH="D:\Program Files\Bluebeam” BB_IE_PLUGIN=1" /qn

Basic silent install; specifies a folder with replacement .JobOptions files:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_
JOBOPTIONS="joboptions" /qn

Basic silent install; specifies a Revu Preferences file to be deployed:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_
REVUPREFERENCES="RevuPreferences.xml" /qn

Basic silent install; specifies use of the red PDF file icon:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_REDICON=1 /qn

Basic silent install; specifies Delayed Authorization, and a Revu Preferences file to be
deployed:

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION={Your Edition} BB_
REVUPREFERENCES="RevuPreferences.xml" DA=1 /qn

Basic silent install of CAD Edition using UNC Paths:

msiexec.exe /i "\\BluebeamServer\Software\bb\Bluebeam Revu x64 16.msi"
BB_SERIALNUMBER={Your SN} BB_PRODUCTKEY={Your PK} BB_EDITION=1 /qn
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Basic silent install of eXtreme Edition with UNC paths and specifying a central location for
Bluebeam settings:

msiexec.exe /i "\\BluebeamServer\Software\bb\Bluebeam Revu x64 16.msi"
BB_SERIALNUMBER={Your SN} BB_PRODUCTKEY={Your PK} BB_EDITION=2 BB_
NETCONFIG="\\Bluebeam Server\Software\bb-config" /qn

Basic silent install of Standard Edition with only the Microsoft Office and AutoCAD plugins
enabled (using the MBCODE parameter 3 (1 for Office + 2 for AutoCAD):

msiexec.exe /i "Bluebeam Revu x64 16.msi" BB_SERIALNUMBER={Your SN}
BB_PRODUCTKEY={Your PK} BB_EDITION=1 MBCODE=3 /qn

See http://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx for more
information on Msiexec command-line options.

http://technet.microsoft.com/en-us/library/cc759262(v=ws.10).aspx
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Appendix D Section 5.04

Bringing it Together: A Fully Configured Deployment

This example provides a step by step overview of implementing customized Bluebeam
settings during deployment. Please note that Revu settings and managed configurations
should be setup on a master configuration machine prior to the actual deployment of the
software.

Problem: Deploying a Bluebeam Update

You are instructed to deploy a Bluebeam minor update within your company.

l Since this is an update, your organization already has customized stamps and custom page
sizes placed in a network folder. You will need to make sure these files are still accessible
once the update is complete.

l Because of a new project that will start soon, you have to create a new profile that will
enhance workflow for everyone on the project. Since everyone will be accessing this profile,
you do not want them to edit it freely.

l Custom toolsets have already been created for the project and the project manager has e-
mailed them to you to add to all systems. The CAD manager needs the ability to update the
tool sets, however typical users should not be able to modify them.

Solution:

1. Setup a Master Configuration Workstation

Install Bluebeam Revu on a single workstation. Once installed, launching Revu should
bring you to the Start Page. Start by setting new preferences from the Settings menu in
the upper-right corner of the interface.
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2. Configure your preferences

If no preferences need to be edited, this step may be skipped.

Preferences Menu

Detailed descriptions of each category in the Preferences window can be found in the
Bluebeam Revu Help Guide. You can access this help guide through the Help menu of
Revu.

a. Export your newly configured preferences

Import/Export buttons are located in the Preferences list.
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When exporting preferences, the default file name given is RevuPreferences.xml.

Save this file to your centralized location in preparation for deployment.

3. Configure your profile
a. Add a New Profile

Add your new profile by clicking on the Manage Profiles button located at the
lower-right corner of the Revu Interface.
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Click Add.

Enter the name of the new profile and click OK.

The new profile will show up in the Manage Profiles dialog box. Click OK.
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Select the profile you just created from the Profiles menu to activate it.

Configure the toolbars and panels as you wish by dragging them into your
preferred position. Click the View menu to enable any tabs and toolbars you
would like to activate.
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b. Add Tool Sets

Select the Manage Tool Sets icon on the Tool Chest tab.

Click Add.

Select Existing since we are adding an existing tool set that was sent via e-mail.
Click the browse (...) button and select the tool set you would like to add. Click
OK when finished.
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The new tool set(s) will now show up within your profile.

Save Profile before exporting or else your changes will not get exported.
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c. Export Your Profile

Save the profile to a centralized location. Be sure to save the Profile (Profiles >
Save Profile) before exporting to include any changes, then click the Manage
Profiles button in the lower-right corner of the interface.

Enable Include Dependencies if you want to include custom tool sets, hatch
pattern sets or line style sets with your profile when it is exported, then click
Export and save the file.

d. Set Profile to Read Only

Set the profile to read-only so it cannot be modified by users, or configure
special permissions to allow designated users the ability to manually save
changes when updates for everyone are desired.
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4. Deploy Bluebeam Revu

Now that your custom preferences and profile have been configured and saved to the
network, configure the deployment with the following settings:

a. Exported preferences file RevuPreferences.xml is located at:
U:\BBcustomsettings\RevuPreferences.xml

b. Custom stamps and currently managed Net Config items are located at:
U:\BBcustomsettings

For best deployment results, follow the Best Practices listed in "Section 1.03 -
Deployment Recommendations" on page 9.

MSI Deploy

MSI Deploy will not automatically remove previous installations of Revu version
12.1 or older, or installations of 12.5/12.6 made via the stand-alone .exe or
InstallShield Silent Setup deployment package. It will automatically uninstall MSI
deployments Revu version 12.5 or higher. If you are upgrading, we have
included a text script named Uninstall Previous Versions.txt that will assist you
in uninstalling any previous version of Bluebeam Revu you may have.

Configure your MSI as shown below or add these Properties to your command
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line and install with elevated permissions.

5. Deploy Custom Profile

After Revu has been installed, the last step of the deployment process is to deploy the
custom Profile. Refer to "Section 4.17 - Revu Command Line Parameters" on page 56
for more information.

"C:\Program Files\Bluebeam Software\Bluebeam
Revu\2016\Revu\Revu.exe" /s /bpximport:"[path]"
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Appendix E Section 5.05

The BB_FEATURES property in the MSI can be used to disable certain features in Revu (See
"Appendix A" on page 59 for more information on MSI Deploy Parameters). When the BB_
FEATURES property value is left at the default of 65535, no features are disabled. To disable
features, subtract their value (found in the list below) from 65535 and use the result as the
BB_FEATURES property value. The following features can be disabled:

EditText = 1

Redaction in eXtreme (Includes Cut Content & Erase Content in all editions) = 2

DigitalSignatures = 4

SelfSignCertificates = 8

Product Updates Button on the Help menu Tab = 16

TranslateMarkups = 32

ExportToOffice = 64

Administrator Button on the Help Menu Tab = 128

Registration Button on the Help Menu Tab = 256

AllFeatures = 255

For example, if you wanted to disable the Bluebeam Administrator button (128) and the
Redaction feature (2), you would find the desired BB_FEATURE property value thusly:

65535 - (128+2) = 65405
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Appendix F Section 5.06

Troubleshooting

Consult the table below for common solutions to issues encountered during and after
installation.

Problem Solution Reference

Revu fails
to install

Ensure the necessary prerequisites are
in place:

l .NET Framework 4.5.0 or higher
l Service Pack 1 for Windows 7
l Previous installations of Revu have

been removed

"Section 1.02 -
Prerequisites" on page 7

"Section 1.05 - Upgrading
Bluebeam" on page 13

Ensure Revu is being installed with
elevated permissions.

"Section 1.06 - MSI Deploy
Installation" on page 15

Before testing your deployment
system, ensure Revu installs properly
from an elevated command prompt.

l Right-click cmd.exe and choose Run
as Administrator. Initiate the install-
ation with the command: msiexec /i

“Name of MSI.msi” /passive.

Check the MSI properties and/or
command line for syntax, spelling and
spacing errors. Remember that paths
in the command line containing spaces
must be enclosed in quotes (" "). Check
the Application Log in the Windows
Event Viewer for errors.

"Appendix A" on page 59

"Appendix C" on page 63
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Revu fails
to register
during
installation

Check the MSI properties and/or
command line to make sure your Serial
Number, Product Key and Edition are
entered correctly and are for the
version/edition you are installing.

"Appendix A" on page 59

"Appendix C" on page 63

Ensure the installation is being run
with elevated permissions.

"Section 1.06 - MSI Deploy
Installation" on page 15

Ensure the account running the install
has Internet access.

Enable Delayed Authorization. "Section 1.04 -
Authorization" on page 11

Configured
properties
are not
applied

Check the MSI properties and/or
command line for syntax, spelling, and
spacing errors. Remember that paths
in the command line containing spaces
must be enclosed in quotes (" "). All
Bluebeam Properties passed through
the command line must be entered in
all caps (for example, BB_EDITION)

"Appendix A" on page 59

"Appendix C" on page 63

Where applicable, verify that the
correct folder paths are used and that
the appropriate files are contained
therein (e.g. RevuPreferences.xml).

Where applicable, verify that the
network resources are mapped and/or
available to the installer.

Bluebeam
PDF Printer
does not
work
immediately
after
installation

Restart the computer once. Some
systems install using the local SYSTEM
account, and the required BbPrint.exe
process may be running under this
account and needs to be running under
the current user.

"Section 1.03 - Deployment
Recommendations" on page
9
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Appendix G Section 5.07

Command Line Options

PbMngr5.exe is the Bluebeam Administrator application found in C:\Program
Files\Bluebeam Software\Bluebeam Revu\2016\Pushbutton PDF. It must be run from
this folder.

These command line options allow you to automate changes to settings in the Bluebeam
Administrator, including product registration, silently via the command line.

Administrator privileges are required to change most of these settings.

/help or /? Shows command line help for PbMngr5.exe.

/about Displays about screen for Bluebeam Revu.

/printername Displays the printer name used by Bluebeam Revu.

/printerdpi <number> Sets the default DPI of the Bluebeam PDF printer.

/reinstallptr Uninstalls and reinstalls the Bluebeam PDF printer

/dvon Makes Bluebeam Revu the default PDF editor.

/dvoff Resets the default PDF editor.

/update Updates Bluebeam authorization server with cur-
rent version and machine name.

/register [<version> <serial num-
ber> <product key> [NoAuth]]1

Register with no parameters will attempt to
register a delayed authorization.

Register with parameters will cross register
between Bluebeam products.

[NoAuth] delays authorization.

/expire Expires trial, forces Revu to be used as a reader.

/setup [options]2 Setup is used to initialize the following options:

/DVON Makes Bluebeam Revu the default PDF editor
(default).

/DVON32 Makes Bluebeam Revu 32 bit the default PDF editor
(off by default).
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/DVOFF Resets the default PDF editor (off by default).
Required parameter to avoid changing default
viewer to Revu.

/IF:<flags>3 Bitwise flags to install plugins into (default
is 0; 1023 enables all plugins3):

Office(1), AutoCAD(2), AutoCAD Lt(4),
SolidWorks(8), Revit(16), Internet Explorer
(32), ProjectWise(64), Outlook(128), Sketchup
(256)

/DPS:[A4 or Letter] Default page size to use with Bluebeam PDF
printer (default is Letter).

/NCPATH:<path> Netconfig path.

/JOPATH:<path> Job options path.

/PREFSPATH:<path> Path to a Bluebeam Revu preferences setup file
used to push out new RevuPreferences to users.
Absolute and UNC paths are supported.

/RED Use Red icon for PDF files (off by default).

/BLUE Use Blue icon for PDF files (default).

/QL Enable Quick Launch of Revu (default is disabled).

/NODESKREVU Prevents the creation of a new desktop shortcut
for Revu (off by default). Does not remove existing
shortcuts.

Notes:

1. The /register command can be used to re-register the product with a different license (for
example, when converting to an Enterprise License).

2. When using the /setup command, values must be specified for all of the options or the set-
tings will revert to defaults, with the exception of the /NCPATH, /JOPATH and /PREFSPATH
options.

3. The /IF parameter is additive. Sum the values of the plug-ins you want to enable. 1023
enables all plugins. Also note that Navisworks is tied to Revit.

Examples:

Register with parameters as below to change your current Bluebeam 2016 licenses (note that
command must be on a single line):
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"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\2016\Pushbutton

PDF\PbMngr5.exe" /register 16 1234567 ABCDE-5FGHIJK

Disable Office Plugins, leaving only the AutoCAD and Internet Explorer plugins enabled:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\2016\Pushbutton
PDF\PbMngr5.exe" /setup /IF:34

Enable the Red icon for PDF files and enable Quick Launch of Revu where all plugins are
enabled:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\2016\Pushbutton
PDF\PbMngr5.exe" /setup /RED /QL /IF:1023

Deploying an updated set of Revu Preferences where all plugins except the Internet Explorer
plugin need to remain enabled:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\2016\Pushbutton
PDF\PbMngr5.exe" /setup /IF:479 /PREFSPATH:"G:\Bluebeam
Software\Settings\RevuPreferences.xml"

When doing this it is recommended that you delete everything else from the XML
so as not to change any other settings.

In order for the preferences to merge, the modified date of the RevuPreferences
file you push out must be newer than date of the UserPreferences.xml file for
the user. If it isn’t, Revu will ignore the preferences so as not to overwrite newer
settings with something that might be outdated. The UserPreferences get saved
when Revu is closed.

When merging preferences, you need to add Merge=”True” (case sensitive) into
the header of this RevuPreferences.xml file:

<RevuPreferenceDictionary Version="1" Merge="True">

Here's an example of pushing out only the setting to turn ON the File Access
Preference "Toolbar Integration Only":

<?xml version="1.0" encoding="utf-8"?>

<RevuPreferenceDictionary Version="1" Merge="True">

<DocManSys>

<ToolbarIntegrationOnlyx64.>True</ToolbarIntegrationO

nlyx64.>

</DocManSys>

</RevuPreferenceDictionary>
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